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Answer KeyClass

7

Touchpad PLUS Ver 2.2

	Number System

Let’s Plug-in  (Page no. 7)

Do it yourself.

Let’s Catch Up  (Page no. 11)
 2 91  

(91)10 = (1011011)2

 2 45 1
 2 22 1
 2 11 0
 2 5 1
 2 2 1

1 0

Let’s Catch Up  (Page no. 12)
	 1	 0	 0	 0		  ·	 1	 0

	 23	 22	 21	 20		  ·	 2–1	 2–2

	 1 × 23 + 0 + 0 + 0	 ·	 2–1 + 0

			   =		  8	 ·	 (½) = 0.5

			   =		  8.5

Let’s Catch Up  (Page no. 13)
10001
– 1001

=  1000

Test Your Skills

1.	 a. (ii)	 b. (i)	 c. (ii)	 d. (i)	 e. (ii)

1.
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2.	 a. T	 b. F	 c. T	 d. T	 e. F

3.	 a. 0	 b. 2	 c. A	 d. 10	 e. 8

4.	 a. � Binary number (11011)2 is equal to (27)10 in decimal.

	 b.  4 bits make 1 nibble.

	 c.  Base of a number system represents the total number of digits in a number system. 

5.	 a.  (11011)2 =(1×24)+(1×23)+(0×22)+(1×21)+(1×20)
		  =(1×16)+(1×8)+(0×4)+(1×2)+(1×1)
		  =16+8+0+2+1
		  =(27)10

	 b.  To convert a decimal number into a binary number, follow these steps:

		  Step 1: Divide the decimal number by 2 (the base of the binary number system).

		  Step 2: Note down the quotient and the remainder.

		�  Step 3: Divide the quotient obtained again by 2 and note down the resulting quotient and 
remainder.

		  Step 4: Repeat the procedure till you reach a quotient less than 2.

		�  Step 5: List the last quotient and all the remainders (moving from bottom to top). You will 
get your binary number.

	 c.	 The rules for binary subtraction:

X Y X – Y
0 0 0 – 0 = 0

0 1 0 – 1 = 1
(borrow 1, so that 10 – 1 = 1)

1 0 1 – 0 = 1
1 1 1 – 1 = 0

6.	 a.	 Determining Odd or Even from Binary Number (1010101)

		�  In binary, the odd/even property of a number is determined solely by its last digit (least 
significant bit).

		  If the last digit is 1, the binary number is odd.

		  If the last digit is 0, the binary number is even.

		  The given binary number is 1010101.

		  The last digit (right most bit) is 1.

		  Therefore, the decimal equivalent of 1010101 is odd.

	 b.	 The octal number 23 can be broken down as:
		  (2 × 81) + (3 × 80)
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		  Now, calculate the values:
		  (2 × 8) + (3 × 1)
		  16 + 3
		  19
	 Therefore, the decimal equivalent of the octal number 23 is 19.

Tech Zone

Let's Solve

Let’s Explore

Do it yourself.

	Charts in Excel 2016

Let’s Plug-in  (Page no. 17)

	 1.	 Suresh	 2.	 Rohit

Let’s Catch Up  (Page no. 19)
	 1.	 Scatter chart	 2.	 Area chart 	 3.	 Bar chart 	 4.	 Pie chart 

Test Your Skills

1.	 a.	 (ii)	 b.	 (ii)	 c.	 (ii)	 d.	 (ii)	 e.	 (iii)
2.	 a.	 F	 b.	 F	 c.	 T	 d.	 T	 e.	 F
3.	 a.	 Chart	 b.	 Gridlines	 c.	 Legend 	 d.	 Column	 e.	 Pie 
4.	 a.	� Gridlines can be either horizontal or vertical lines depending on the selected chart type. It 

makes it easier to read and understand the values.
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	 b.	 Legend is a key which shows the meanings of symbols and colours used in the chart.
	 c.	 Bar chart displays the data in the form of long rectangular rods, also called bars.
	 d.	 Area chart is used to display the quantitative magnitude of the data graphically.
5.	 a.	� Line Chart: It is used to show trends over a period of time. It is similar to plotting a graph 

on a graph paper with its values on X and Y axis. It uses connecting dots to display trends 
of a data over a given period of time. Whereas Scatter charts are also known as XY scatter 
plot charts. They show the correlation between the two sets of values. The x and y axes are 
used to represent the data plots on the chart.

	 b.	 The five components of charts are as follows:
		�  Data Series: It is related to the set of values. It is represented by the bars or slices that 

represent the data values.
		�  Data Labels: It includes data values, category name, series name, legend keys and values 

from cells.
		�  Gridlines: These can be either horizontal or vertical lines depending on the selected chart 

type. It makes it easier to read and understand the values.
		  Legend: It is a key which shows the meanings of symbols and colours used in the chart.
		  Chart Area: It includes all the objects and elements of a chart.
	 c.	 Follow these steps to change the chart type:
		  Step 1: Select the chart.
	 	 Step 2: Click on the Change Chart Type command from Type group under the Design tab.
		  Step 3: Click on Line option from the left panel of the Change Chart Type dialog box.
		  Step 4: Click on Line with Markers option from the right panel.
		  Step 5: Select the desired Line with Markers chart style. 
	 	 Step 6: Click on OK button.
		  The chart will change to Line Chart.
6.	 a.	 Pie chart
	 b.	 Column chart

Tech Zone

Let's Solve
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Let’s Explore

Do it yourself.

Periodic Assessment–1
(Based on chapters 1 & 2)

A.	 1.	 The rightmost digit before the fractional part of a binary number is known as LSD.
	 2.	 Hexadecimal number system consists of 16 symbols from 0 to 9 and A to F.
	 3.	 In BEDMAS rule, E stands for exponents.
	 4.	 Legend is a key which shows the meanings of symbols and colours used in the chart.
	 5.	 Scatter chart is also known as XY plotter chart.
B.	 1.	� It is commonly used to display the data in the form of vertical bars. It is used to show the 

changes in data over a period of time or comparison among different data items. This chart 
can be used to depict and compare the results of your friends.

	 2.	� It is a circular chart divided into sectors where each sector shows the relative size of each 
value. It always shows only one data series. You can use pie chart to explain the distribution 
of the various gasses in the atmosphere.

	 3.	� It is used to display the quantitative magnitude of the data graphically. You can use this 
chart to show the level of depletion of ozone layer in the atmosphere.

	 4.	� Bar chart displays the data in the form of long rectangular rods also called bars. This chart 
can be used to differentiate the individual element of any comparison. You can use this chart 
to show Cost Price and Selling Price of different items.

	 5.	� They show the correlations between the two sets of values. This chart can be used to show 
the relation between the degradation of soil quality due to the increase in population.

C.	 1.	 Decimal	 Octal 	 Scientific	 Binary
	 2.	 A 	 C		  F		  H
	 3.	 Bar 	 Pie 	 Data 	 Column 
	 4.	 Int 	 Bit 	 Nibble 	 Byte
D.	  1.	 c.	 2.	 e.	 3.	 b.	 4.	 a.	 5.	 d.

	Advanced Features of Excel

Let’s Plug-in  (Page no. 26)

	 1.	 False		  2. True		  3. True			   4. False

3.
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Let’s Catch Up  (Page no. 28)
Sorting refers to the process of arranging data in ascending or descending manner. It helps us to 
obtain data quickly and work efficiently.

Test Your Skills

1.	 a.	 (i)	 b.	 (ii)	 c.	 (ii)	 d.	 (ii)	 e.	 (ii)
2.	 a.	 F	 b.	 F	 c.	 F	 d.	 T	 e.	 F
3.	 a.	 Conditional formatting can be applied on the following criteria: 
		    i. Highlight Cells Rules 
		   ii. Top/Bottom Rules
		  iii. Data bars 
		  iv. Color Scales 
		   v. Icon sets 
	 b.	 Go to the Data tab and click on the Clear button in the Sort & Filter group to remove filters.
	 c.	 Filter command is used to hide unimportant data.
4.	 a.	� Sorting data refers to the process of organizing data in ascending or descending order. 

Whereas, filtering data refers to remove or hide the unimportant data to emphasise on the 
important information.

	 b.	 To apply conditional formatting to a series of data, follow these steps: 
		  Step 1:	 Select the data to which formatting is to be applied. 

		  Step 2:	� Click on the Conditional Formatting command from Styles group under Home tab. 
A drop-down list appears. This list shows various criteria. 

		  Step 3:	� Select the desired conditional formatting. The selected conditional formatting is 
applied to the selected cell range.

	 c.	 To use Custom Sorting, follow these steps:
	 	 Step 1:	 Select the range of columns to be sorted.

		  Step 2:	 �Click on the Sort & Filter command from the Editing group under Home tab. A 
drop-down list appears.

		  Step 3:	 Click on the Custom Sort option from the drop-down list.

		  Step 4:	� Check My data has headers checkbox, if the selected columns have a heading at 
the top.

		  Step 5:	 �Click on the Sort by box and select the column header according to which you want 
to sort the data.

		  Step 6:	 Click on the Sort On box and select Cell Values option.

		  Step 7:	� Click on the Order box and select the A to Z or Z to A option.
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		  Step 8:	� Click on the Add Level button at the top of the Sort dialog box to add another 
column to sort.

		  Step 9:	 Click on the OK button.

		  The data will be sorted according to the criteria defined.

5.	 a.	 John can use the Sort feature in Excel.

		�  He should go to the Home tab → Sort & Filter → Sort A to Z to arrange student names in 
ascending order quickly and efficiently.

	 b.	 To highlight scores below 50 in red and above 80 in green, use Conditional Formatting:

		  Step 1:	 Select the score range.

	 	 Step 2:	� Go to Home tab → Conditional Formatting → New Rule → Format only cells that 
contain.

	 	 Step 3:	 Set one rule for less than 50 and format it with red fill.

		  Step 4:	 Set another rule for greater than 80 and format it with green fill.

		  Benefits:

	 	 •  Makes important data stand out visually.

	 	 •  Helps in quick analysis and decision-making.

	 	 •  Saves time by automatically applying formatting based on conditions.

Tech Zone

Let's Solve

	 a.	 Editing 		 b. Filter 		 c. Sort 		  d. Conditional Formatting

	 e.	 Sort A to Z (for text) and Sort Smallest to Largest (for numbers) 

Let’s Explore

	 Do it yourself.

Tech Practice

Do it yourself.

	More on Animate 2024

Let’s Plug-in  (Page no. 35)

1.	 True	 2. False		  3. True		  4. True

Let’s Catch Up  (Page no. 38)
1.	 Three 	 2. Frame 1 of Layer 1	 3. Frames Per Second	 4. Symbol

4.
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Test Your Skills

1.	 a.	 (ii)	 b.	 (iii)	 c.	 (iv)	 d.	 (iii)	 e.	 (ii)
2.	 a.	 Masking 		  b.  Layers	  	 c.  Properties	  	 d.  Break Apart
3.	 a. 	 T 		  b.  T 		  c.  F 		  d.  T 
4.	 a.	 The movement of an object in-between the frames is called Tween.
	 b.	 Masking in Animate is used to hide a selected part and display content of a specific layer.
	 c.	� Classic Tween is used for transition purpose, whereas Motion Tween uses symbols to create 

movement, size, rotation changes, fades, etc.
5. 	 a.	� Layers are sheets on which you place your drawings, animations and objects. They allow 

you to keep the elements of the animation separate. These are similar to transparent sheets, 
stacked one on top of the other.

	 b.	 Perform the following steps to format text in Animate:
	 	 Step 1:	 Click on the Text Tool from the Tools panel.
		  Step 2:	 Specify the font size, colour, style, etc. under the Properties panel. 
		  Step 3:	 Drag and create a text box on the stage. 
		  Step 4:	 Type the text ANIMATE on the stage. 
		  To individually split the text and modify it, Break Apart option can be used. 
		  Step 5:	 Select the text by using the Selection Tool. 
		  Step 6:	 Select the Modify → Break Apart option from the Menu bar. 
		  Step 7:	 Select the individual character and change the colour.
6.	 a.	 To individually split the text and modify it, Break Apart option can be used. 
	 b.	 Neeraj should use the Shape Tween.

Tech Zone

Let’s Explore

	 Do it yourself.

Let's Solve
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Tech Practice

Do it yourself.

Periodic Assessment–2
(Based on chapters 3 & 4)

A.	 1.	 Sorting data means to organise the data in ascending or descending order.

	 2.	� Filtering data refers to remove or hide the unimportant data to emphasise on the important 
information. 

	 3.	 The movement of an object in-between the frames is called Tween.

	 4.	 Layers are sheets on which you place your drawings, animation and objects.

B.	

New Layer

View only 
Active Layer

Lock or Unlock 
All Layers

Show or Hide 
All LayersNew Folder Delete

C.	 Ritika should use the Sort A to Z option from the Sort & Filter command.

Test Sheet–1
(Based on chapters 1 to 4)

A.	 1.  (ii)	 2.  (i)	 3.  (i)	 4.  (ii)	 5.  (ii)

	 6.  (ii)	 7.  (iii)	 8.  (ii)

B.	 1.  T	 2.  T	 3.  F	 4.  F	 5.  T

	 6.  F	 7.  F

C.	 1.  0		  2.  2		  3.  Filter		 4.  Pie		  5.  Properties

	 6.  Break Apart

D.	 1.	Sorting data means to organise the data in ascending or descending order.
	 2.	Go to the Data tab and click on the Clear button in the Sort & Filter group to remove filters.
	 3.	The octal number system consists of eight digits from 0 to 7. Hence, the base of octal number 

system is 8. 
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	 4.	 Masking in Animate is used to hide a selected part and display content instead on a layer.

		  Masking enables us to control the content that is visible to the audience.

E.	 1.	 To apply conditional formatting to a series of data, follow these steps:

	 	 Step 1:	 Select the data to which formatting is to be applied.

	 	 Step 2:	� Click on the Conditional Formatting command from Styles group under Home tab. 
A drop-down list appears. This list shows various criteria.

	 	 Step 3:	 �Select the desired conditional formatting. The selected conditional formatting is 
applied to the selected cell range. 

	 2.	 Conditional formatting can be applied on the following criteria:

		  i. Highlight Cells Rules ii. Top/Bottom Rules iii. Data bars

		  iv. Color Scales v. Icon sets

	 3.	� In binary subtraction, binary number of lower value is subtracted from the binary number 
of higher value. The following table explains the subtraction of digit Y from digit X. If Y is 
greater than X, then 1 is borrowed from the next position. When the binary digit 0 borrows 
1 from the next most significant digit, it becomes 10.

		  The rules for binary subtraction:

		

X Y X – Y
0 0 0 – 0 = 0

0 1
0 – 1 = 1

(borrow 1, so that 10 – 1 = 1)
1 0 1 – 0 = 1
1 1 1 – 1 = 0

	 4.	� Classic Tween is used for transition purpose, whereas Motion Tween uses symbols to create 
movement, size, rotation changes, fades, etc. 

	 5.	� Gridlines can be either horizontal or vertical lines depending on the selected chart type. It 
makes it easier to read and understand the values.

	 6.	 Follow these steps to change the chart type:

		  Step 1:	 Select the chart.

		  Step 2:	 Click on the Change Chart Type command from Type group under the Design tab.

		  Step 3:	 Click on Line option from the left panel of the Change Chart Type dialog box.

		  Step 4:	 Click on Line with Markers option from the right panel.

		  Step 5:	 Select the desired Line with Markers chart style. 

		  Step 6:	 Click on OK button. 

		  The chart will change to Line Chart as shown. 
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	 Internet Services

Let’s Plug-in  (Page no. 56)

	

Facebook Instagram YouTubeX

Test Your Skills

1.	 a.  (i)	 b.  (i)	 c.  (iv)	 d.  (iv)	 e.  (ii)
2.	 a.  T	 b.  F	 c.  F	 d.  T	 e.  T
3.	 a.  cash on delivery		 b.  communicate, information		  c.  blogger
	 d.  questions		  e.  cloud storage
4.	 a.	 Facebook, X and Instagram.
	 b.	 Net Banking and E-Wallet.
	 c.	 You are not allowed to post political content and poorly phrased questions.
	 d.	 This feature lets you find all your active Facebook logins from any device. 
	 e.	 (i) Your sensitive data might be at risk from hackers.
		  (ii) Some people might face issues like data loss.
5.	 a.	 Blog is a short form of WEBLOG, which refers to a website where new information about any 

topic is updated regularly. The latest posts appear first. The term Weblog was coined by an 
American blogger named Jorn Barger in 1997. It is like a journal where you write about your 
life and thoughts. Types are travel blog, fashion blog etc. 

	 b.	 The key features of Skype are as follows:
	 	 •  Skype translates the conversation in real-time if the person is talking in a different language.
	 	 •  It is a safe way to have conversation with people without any interruption.
	 	 •  You can share your screen to train someone.
	 	 •  It has Live Subtitles option. This helps a hearing-impaired person to keep up with the call. 
	 c.	 1.  It fetches the updated web feed. 
		  2.  It provide newly published information from the website/blog directly to you.
		  3.  It saves your time.
	 d.	 Website is a collection of static pages such as home page, contact page, profile page. On the 

other hand, blog contains both pages and posts but mostly posts. Websites usually don’t 
change regularly as blogs do.

6.	 a.	� Shreya and Tina can use a cloud storage service like OneDrive, Google Drive, or Dropbox to 
upload, share, and collaborate on files in real-time. 

5.
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	 b.	� Rihan can use social media platforms like Facebook, Instagram, or LinkedIn to search and 
reconnect with his old school friends by their names, locations, or mutual contacts.

Tech Zone

Let's Solve
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Let’s Explore

	 Do it yourself.

Tech Practice

Do it yourself.

	App Development

Let’s Plug-in  (Page no. 73)

Do it yourself.

Let’s Catch Up  (Page no. 74)
The application that is mainly developed for computer or laptop is called a desktop application 
whereas Web app is an application program that is stored on a remote server and accessed over 
the Internet through a Web browser interface.

6.
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Let’s Catch Up  (Page no. 75)

  Instagram	   Camera

Test Your Skills

1.	 a.	 (iv)	 b.	 (iii)	 c.	 (iv)	 d.	 (ii)	 e.	 (i)
2. 	 a.	 Application	 b.	 Native	 c.	 Gaming	 d.	 Educational	 e.	 Social networking 
3.	 a.	� An app is a software program primarily developed for hand-held smart devices such as 

mobile and tablet.

	 b.	 E-commerce apps allow us to buy or sell products while sitting at home or any other place. 

	 c.	� Native apps are the type of Mobile apps. These are platform dependent which means that 
these apps are primarily developed for a specific platform.

	 d.	 Component Blocks, Backpack and Trash 

4.	 a.	 (i)  �Gaming Apps- Today’s most popular category of mobile apps is gaming apps which 
share more than 24% area of the app store. The most commonly used gaming apps are 
Call of Duty, Candy Crush Saga, and Angry Birds.

		  (ii)  �Productivity Apps: Productivity apps, also known as business apps used by businessmen 
to perform several complex tasks. The most commonly used productive apps are Google 
Calendar, Evernote and Dropbox.

		  (iii)  �Entertainment Apps: Entertainment apps are developed to entertain the people. The 
most commonly used entertainment apps are Netflix, Disney Plus Hotstar and YouTube.

	 b.	 To change the display name, follow the given steps:

		  Step 1:	 Click on the button in the Viewer pane.

		  Step 2:	 Type a new name for button in the Text box.

	 c.	� The difference between web app and website is that a web app can be a small part of a 
website which provides a particular functionality. On the other hand, a website can contain 
many web apps.

	 d. 	� Educational apps provide a platform for children to learn from anywhere and anytime. These 
apps use advance methodologies and new concepts to make the learning easier. The most 
commonly used educational apps are Khan Academy, Vedantu, and Learn English Grammar.

5.	 a.	 Gaming Apps 

	 b.	 YouTube 
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Tech Zone

Let's Solve

	 a.	 Mobile App 		  b.  Google Play Store	 c.  iOS 		  d.  Web application

	 e. App Store		  f.  Hybrid apps				    g.  Gaming apps

	 h.  Educational apps	 i.  Social networking apps 		  j.  Web apps

Let’s Explore

	 Do it yourself.

Tech Practice

Do it yourself.

	More on HTML5

Let’s Plug-in  (Page no. 89)

1.  what you see is what you get 		 2.  hyperlink 		  3.  HTML5

Let’s Catch Up  (Page no. 94)
text-align

Test Your Skills

1.	 a.	 (ii)	 b.	 (ii)	 c.	 (ii)	 d.	 (iv)	 e.	 (iii) 
2. 	 a.	 T	 b. 	 F	 c.	 F	 d.	 T	 e.	 T
3.	 a.	 <P>	 b.	 horizontal	 c.	 <sub>	 d. 	 color
	 e.	 background-image
4.	 a.	� <H3>This is a third level heading</H3>

	 b.	 The CSS properties used are:

		  •  font-family

		  •  text-align

		  •  color

	 c.	� background-repeat  

5.	 a.	 Property Value
font-family Name of the font
font-size Value is given in pixels. The default font size for the text is 16 px. 

7.
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	 b.	 Ravi should use the text-decoration property to underline text.

		  <p style="text-decoration: underline;">This is underlined text.</p>

6.	 a.	� To display each book title in different fonts and colours, Himani should use the following 
font properties in CSS:

		  •  font-family – to set different font styles (e.g., Arial, Verdana, Times New Roman)

		  •  color – to apply different text colours (e.g., red, blue, green)

	 b.	� To set his photo as a background on the web page, Dhanush can use the background-image 
property in CSS.

Tech Zone

Let's Solve

	 Do it yourself. 

Let’s Explore

	 Do it yourself.

Tech Practice

Do it yourself.

	Lists and Tables in HTML5

Let’s Plug-in  (Page no. 102)

Do it yourself.

Let’s Catch Up  (Page no. 107)
An ordered list is used to display the items in sequential manner. Whereas, an unordered list is used 
to display random items which never require to place in a sequential manner.

Let’s Catch Up  (Page no. 113)
Do it yourself. 

Test Your Skills

1.	 a.	 (i)	 b.	 (ii)	 c.	 (ii)	 d.	 (ii) 
2. 	 a.	 T	 b.	 F	 c.	 F	 d.	 F	 e.	 T 
3.	 a.	 START, TYPE	 b.	 disc	 c.	 <TH>	 d.	 border-style	 e.	 Table Data
4.	 a.	� We use the <UL> tag to create an unordered list where items are displayed with bullets 

instead of numbers or letters.
	 b.	 <OL TYPE="a">

8.
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	 c. 	� The border-spacing property is used to specify the space between the borders of adjacent 
cells. 

		 Syntax: 

		 table {

		   border-spacing: 10px;

		 }

5.	 a.	� table {
		    border:3px; 

		    border-style:solid; 

		    border-color:red; 

		 }

	 b.	� 1.  border – Specifies the thickness of the table border.
		  2.  cellpadding – Sets the space between the cell content and its border.
		  3.  cellspacing – Sets the space between two table cells.
		  4.  width – Defines the width of the table.
	 c.	� The ROWSPAN attribute applies when a single cell is extended for more than a single row and 

the COLSPAN attribute applies when a single cell is extended to more than a single column.
6.	 a.	 Himesh should use the <TABLE> tag to display the marks in a structured format.
	 b.	 Nidhi should use the COLSPAN attribute to extend data across multiple columns.

Tech Zone

Let's Solve
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Let’s Explore

	 Do it yourself.

Tech Practice

Do it yourself.

Periodic Assessment–3
(Based on chapters 5 to 8)

A.	 <body bgcolor=”red”>

	 <p> and not </p>

	 Need to close the <p> at the end of the paragraph

B.	� 1.	 Google Assistant 	 2.  GooglePay 		  3.  SBI Net Banking

	 4.	 LinkedIn		  5.  Olx

C.	� 1.	� The ROWSPAN attribute applies when a single cell is extended for more than a single row, 
that is, the cell spans for 2 or more rows instead of 1.

	 2.	 It specifies the font of the text on a web page.

	 3.	 It is used to set an image as the background of a web page.

	 4.	 The border property of CSS allows you to apply a border to an element of HTML.

	 5.	� The border-spacing property is used to specify the space between the borders of adjacent 
cells.

	Algorithmic Intelligence

Let’s Plug-in  (Page no. 118)

1.  AA2 	 BB4 	 CC3 	 DD8

2.  AB 	 DF 	 GH 	 JK

3.  1234 	 6789 	 2354 	 4567

4.  0001 	 1002 	 0101 	 0111

Let’s Catch Up  (Page no. 119)
1.	 0010 (2), 0011 (3), 0101 (5), 0111 (7)

2.	 0010 (2), 0100 (4), 0110 (6), 1000 (8), 1010 (10)

3.	 5 (0101) + 4 (0100) = 9 → 1001

4.	 0011 (3), 0110 (6), 1001 (9)

9.
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Let’s Catch Up  (Page no. 121)
Do it yourself. 

Test Your Skills

1.	 a.	 (iii)	 b.	 (i)	 c.	 (ii)
2.	 a.	 F	 b.	 F 	 c.	 T	 d.	 F
	 e.	 T	 f.	 T	 g.	 F
3.	 a.	 Information processing involves acquiring, storing, analysing, retrieving, and displaying data.
	 b.	 An algorithm is a set of step-by-step instructions in a sequential manner to solve a problem.
	 c.	� Binary code is the most basic form of data that a computer can directly interpret. Computers 

use binary code, composed of 1s and 0s, to store and process data.
4.	 a.	� Computers use binary code, composed of 1s and 0s, to store and process data. These 1s and 

0s represent electrical signals: ON for 1 and OFF for 0. For instance, the number 5 is stored 
as 0101 in binary.

	 b.	� The program executes the statements written inside the IF block when the condition is True. 
If the condition is False, the statements written inside the else block will be executed.

	 c.	 READ Day  
		  IF Day = "Sunday" THEN  
		  PRINT "picnic"  
		  ELSE  
		  PRINT "School"
5.	 a.	 Do it yourself.
	 b.	 Do it yourself.

Tech Zone

Let's Solve

	 1.	 READ Number  
		  IF Number % 3 = 0 THEN  
		  PRINT "Number is divisible by 3"  
		  ELSE  
		  PRINT "Number is not divisible by 3"

	 2.	 Do it yourself.
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	 3.	 READ number
If (number is 1) then colour Blue
If (number is 2) then colour Green
If (number is 3) then colour Yellow 
If (number is 4) then colour Purple

		  4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4
4 4
4 2 2 3 3 1 1 4
4 2 2 3 3 1 1 4
4 2 2 1 1 3 3 4
4 2 2 1 1 3 3 4
4 2 2 1 1 4
4 2 2 1 1 3 3 4
4 3 3 4
4 4
4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4

Tech Practice

Do it yourself.

	Conditional Statements in Python

Let’s Plug-in  (Page no. 126)
	 1.  True	 2.  84	 3.  8 2 20 	 4.  True	 5.  22

Let’s Catch Up  (Page no. 129)

The error in the code is due to incorrect indentation and the use of wrong quotation marks (‘ ’ instead 
of ' ' or " "), and missing colon : after if(age > 18).

Test Your Skills

1.	 a.  (i)	 b.  (ii)	 c.  (iv)	 d.  (iii)

2.	 a. Conditional statements	 b. false	 c. top-down	 d. non-zero

3.	 a.  F	 b.  F	 c.  T	 d.  T

10.
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4.	 a.	 Conditional statements, also known as decision-making or control flow statements, are used 
in programming to execute different blocks of code based on certain conditions. 

	 b.	if (Test Expressions_1): 
		      Indented block 1 

		  elif (Test Expression_2): 

		      Indented block 2 

		  elif (Test Expression_3): 

		      Indented block 3 

		  else: 

		      Indented block 

	 c.	 if (Test Expression):
		      Indented statement block   

		  # if block ends here

5.	 a.	 The if...else statement checks for a condition. If the condition evaluates to True, the indented 
block following the if statement is executed; otherwise, the indented block after the else 
statement is executed. 

	 b.	 This means that you have an if statement inside another if statement. The inner if block will 
run only when the first if condition evaluates to true. 

6.	 a.	 age = int(input("Enter the age of the member: "))

		  if age < 18:

		      fee = 500

		  else:

		      fee = 700

		  print("The membership fee is: ", fee, "per month.")

	 b.	 Maria should use the if...elif...else statement to categorize students into different grade levels 
based on their age.

		  age = int(input("Enter the age of the student: "))

		  if age <= 11:

		      grade = "Elementary School"

		  elif age <= 13:

		      grade = "Middle School"

		  velse:

		      grade = "High School"

		  print("The student is in: ", grade)
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Tech Zone

Let's Solve

	 1.	 Enter a First Number: 15

		  Enter a Second Number: 10

		  First number is greater than second number 

	 2.	 Positive number

	 3.	 Above ten

		  and also above 20!

	 4.	 b is not greater than a

Let’s Explore

	 Do it yourself.

Tech Practice

	 Do it yourself.

	AI for SDGs

Let’s Plug-in  (Page no. 139)
	 1.  True	 2.  84	 3.  8 2 20 	 4.  True	 5.  22

Let’s Catch Up  (Page no. 143)

	 1.  T	 2.  T	 3.  F

Test Your Skills

1.	 a. (ii)	 b. (i)	 c. (ii)

	 d. (iii)	 e. (i)	 f. (ii)

2.	 a. SDG 	 b. 70 	 c. 17.2 	 d. marine pollution

3.	 a. T 	 b. T 	 c. F 	 d. T

4.	 a. �AI can help in improving the farming land, agriculture, quality of products, etc. AI can also 
help with aid distribution in poor and war-torn areas, or where natural disasters have caused 
heavy destruction.

11.
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	 b. �AI can help in achieving this goal by increasing the ability of healthcare professionals to analyse 
huge data sets, providing better feedback and finding accurately the cause of diseases to 
discover the cure.

	 c. �This SDG aims at protecting, restoring and promoting the sustainable use of terrestrial 
ecosystems, managing forests, fighting deforestation, reversing land degradation and stopping 
biodiversity loss. 

5.	 a. �Improving gender equality empowers women to participate fully in the economy, leading to 
increased productivity, innovation, and income. When women have equal access to education, 
jobs, and decision-making, it boosts economic development and reduces poverty.

	 b. �AI for climate action has the potential to reduce global greenhouse gas emissions by up to 4 
percent. Using AI and data from NASA, researchers are able to identify patterns and monitor 
changes of land surfaces such as decreasing sea area, ice cap surfaces, etc.

	 c. �AI in education can be used to achieve Quality Education goals by developing smart content, 
providing personalized guidance, round the clock assistance, virtual learning environment 
and creating more secured online exams.

6.	 a. �The tree-planting initiative to combat climate change and enhance biodiversity relates to 
SDG 13 (Climate Action) and SDG 15 (Life on Land).

	 b. �Gaurav is promoting SDG 5 (Gender Equality) by raising awareness about gender equality in 
sports.

Tech Zone

Let's Solve

		  Do it yourself.

Let’s Explore

	 Do it yourself.

Tech Practice

Do it yourself.

Periodic Assessment–4
(Based on chapters 9 to 11)

A.	 Congratulations!!!

	 You have passed the exam

B.	 1. 	 SDG 2 aims to end hunger issues by 2030 and ensure access to nutritious food for all children.

	 2.	 SDG 5 aims to achieve gender equality and empower all women and girls.



23Touchpad PLUS (Version 2.2)-VII (Answer Key)

	 3.	 SDG 8 aims to lesson the youth unemployment.

	 4.	� SDG 10 aims to ensure equal opportunities and end discrimination by eliminating 
discriminatory laws, policies and practices.

	 5.	� SDG 15 aims at protecting, restoring and promoting the sustainable use of terrestrial 
ecosystems, managing forests, fighting deforestation, reversing land degradation and 
stopping biodiversity loss.

C.	 if (Test Expressions_1): 

	    Indented block 1 

	 elif (Test Expression_2): 

	    Indented block 2 

	 elif (Test Expression_3): 

	    Indented block 3 

	 else: 

	    Indented block 

Test Sheet–2
(Based on chapters 5 to 11)

A.	 1.  (iii)	 2. (iii)	 3. (ii)	 4. (i)	 5. (ii) 
	 6. (ii) 	 7. (i)	 8. (iv) 	 9. (ii) 	 10. (i) 
B.	 1. if 	 2. true 	 3. Gaming	 4. list item 	 5. <UL>
	 6. markup
C.	 1. F	 2. T	 3. T	 4. F	 5. F
	 6. T	 7. T
D.	 1. �In Python, variables are used to store data values. You can assign a value to a variable using 

the = operator, and the variable can store various data types like integers, strings, lists, etc.
	 2. �Conditional statements, also known as decision-making or control flow statements, are used 

in programming to execute different blocks of code based on certain conditions. 
	 3. �Empty tag: An HTML tag that does not have any content or closing tag (e.g., <img>, <br>, 

<hr>).
	     �Container tag: An HTML tag that has both an opening and a closing tag and contains content 

between them (e.g., <p>Content here</p>, <div>Content here</div>).
	 4.  Information processing involves acquiring, storing, analysing, retrieving, and displaying data. 
E.	 1. �Control statements are used to control the flow of execution in a program. Types include:
	     •  Conditional: if, if-else, if-elif-else
	     •  Loops: for, while
	     •  Jump: break, continue
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	 2. <hr> Tag Attributes:
	     •  width: Defines width of the line.
	     •  size: Defines the height of the line.
	     •  color: Defines color of the line.
	     •  align: Aligns the line (left, center, right).
	     •  noshade: Removes shading of the line.
	 3. �Website is a collection of static pages such as home page, contact page, profile page. On the 

other hand, blog contains both pages and posts but mostly posts. Websites usually don’t 
change regularly as blogs do. 

	 4. �This SDG aims to guarantee justice and freedom for all people by 2030. The target is to 
significantly reduce all forms of violence with communities and governments to end conflict 
and insecurity. 

	 5. <!DOCTYPE html>
	     <HTML>
	     <HEAD> <TITLE> Students of Class 7 </TITLE>
	     <STYLE>
	     TABLE, TH, TD
	     {
	     border:2px;
	     border-style:solid;
	     border-color:green;
	     }
	     </STYLE>
	     </HEAD>
	     <BODY>
	     <TABLE>
	     <CAPTION> Table : Student </CAPTION>
	     <TR>
	     <TH> Roll No. </TH>
	     <TH> Name </TH>
	     <TH> Grade </TH>
	     <TH> Gender </TH>
	     </TR>
	     <TR>
	 6.  �The program executes the statements written inside the IF block when the condition is True. 

If the condition is False, the statements written inside the else block will be executed. 
F.	 day_number = int(input("Enter a number between 1 and 7 (1 for Monday, 7 for Sunday): "))
	 # Check and display the corresponding day
	 if day_number == 1:
	     print("Monday")
	 elif day_number == 2:
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	     print("Tuesday")
	 elif day_number == 3:
	     print("Wednesday")
	 elif day_number == 4:
	     print("Thursday")
	 elif day_number == 5:
	     print("Friday")
	 elif day_number == 6:
	     print("Saturday")
	 elif day_number == 7:
	     print("Sunday")
	 else:
	     print("Invalid input! Please enter a number between 1 and 7.")
G.	 num1 = int(input("Enter the first number: "))
	 num2 = int(input("Enter the second number: "))
	 if num1 > num2:
	     print("First number is greater than second number")
	 elif num2 > num1:
	     print("Second number is greater than first number")
	 else:
	     print("Both numbers are equal")


